Release Notes for Modo 12.2v1

Release Date
15 November 2018

System Requirements

Officially Supported Operating Systems

• Mac OS 10.12.x, 10.13.x, and 10.14.x (64-bit only)
• Windows 7, Windows 8, and Windows 10 (64-bit only)
• Linux 64-bit operating system (CentOS/RHEL 7+)

Minimum Hardware Requirements

• Intel processor(s), Core i3 or higher
• 1 GB available hard disk space (for Modo installation).
• 6 GB available hard disk space (for full content).
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements

⚠️ NOTE: This information is our best recommendation for the average user. Requirements vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor
• 250+ GB disk space available for caching and temporary files, SSD is preferable
• 16 GB RAM with additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphics memory
• OpenGL 4.4 or higher support
*The use of virtual memory improves stability and helps prevent data loss on large projects.

Recommended Graphics Driver Versions

• NVIDIA: 411.63 or later*
• AMD: 8.982.8.1 or later*

*We recommend downloading the latest driver version from the NVIDIA or AMD websites

Tested Workstation Hardware

The configurations listed below are those that Foundry have tested with Modo 12.2v1. Due to the constantly changing nature and wide variety of computer hardware available in the market, Foundry is unable to officially certify hardware. The list below can be used as a recommendation and does not guarantee that it meets your particular needs.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

<table>
<thead>
<tr>
<th>Tested Workstation Hardware</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple</td>
<td>• MacBook Pro (Retina, 15-inch, Mid-2015)</td>
</tr>
<tr>
<td></td>
<td>• iMac (Late 2012)</td>
</tr>
<tr>
<td></td>
<td>• Mac Pro (Late 2013)</td>
</tr>
<tr>
<td></td>
<td>• MacBook Pro (Mid-2015)</td>
</tr>
<tr>
<td>Dell</td>
<td>• XPS 15 9560</td>
</tr>
<tr>
<td></td>
<td>• Precision 3520</td>
</tr>
<tr>
<td>HP</td>
<td>• HP Z800</td>
</tr>
<tr>
<td></td>
<td>• HP Z640</td>
</tr>
<tr>
<td></td>
<td>• HP Z600</td>
</tr>
<tr>
<td>CPU</td>
<td>• AMD Ryzen Threadripper</td>
</tr>
<tr>
<td></td>
<td>• Intel i7-4770k</td>
</tr>
<tr>
<td></td>
<td>• Intel i7-7700k</td>
</tr>
<tr>
<td></td>
<td>• Intel i7-8700</td>
</tr>
<tr>
<td></td>
<td>• Xeon E3-1505M v6</td>
</tr>
<tr>
<td></td>
<td>• Xeon E5504</td>
</tr>
<tr>
<td></td>
<td>• Xeon 5620</td>
</tr>
</tbody>
</table>
## Tested GPU Hardware

| AMD Prosumer Graphics Cards | • Radeon™ Vega RX  
|                           | • Radeon™ R9 M370X  
|                           | • Radeon™ Pro WX8200  
|                           | • Radeon™ Pro WX7100  
| AMD Enterprise Graphics Cards | • FirePro™ D700  
| NVIDIA Prosumer Graphics Cards | • GeForce 675MX  
|                           | • GeForce 970  
|                           | • GeForce 1050 (laptop)  
|                           | • GeForce GTX 1070 Ti (Linux)  
|                           | • GeForce 1080  
| NVIDIA Enterprise Graphics Cards | • Quadro® K620  
|                           | • Quadro® M620  
|                           | • Quadro® M4000  

## New Features

### Animation and Rigging

### Groups and Channels Viewport Filters and Search

You can now filter the **Groups** and the **Channels** viewport. The **Channels** viewport can also be filtered in the **Graph Editor**.

### Int Range Nodes

A set of nodes have been added for manipulating integer range values. They are:

- **Int Range Bounds**
- **Int Range Clamp**
- **Int Range Merge**
- **IntrangeTest**

### Saving Envelope Presets from the Graph Editor

Modo now allows you to save and load Envelope Presets directly from the Graph Editor.
Schematic Improvements

The following improvements have been made to the Schematic viewport:

- **Show Instance Connections** - You can now view links from instances to their original objects. They are drawn with a dotted connector.
- **Show Connected Nodes** - You can now isolate a nodal network based on the selection of a single node. With an item selected, all other nodes not connected to that node are hidden.
- **Elbow Node** - This node helps you organize the Schematic by reducing the number of visible and crossing links.
- **Draw Linear Link Option** - You can now choose to draw Schematic links as straight lines, which are easier to read in complex networks.
- **Comment Node** - You can now leave comments in the Schematic using the Comment node.
- **Backdrop Node** - Backdrops allow you to group nodes into a container that can be collapsed and moved around.
- **Organized Duplication** - When you duplicate nodes, their layout is now preserved in the new nodes and they are selected ready to be placed in the Schematic. You can either duplicate a node with or without its connections.

AVP and VR

Selections Visible Through Geometry

Modeling in the Advanced viewport is now much easier as you can now see selections through shaded geometry in either a foreground or background layer.

Points Anti-aliased and Independent Point Size

Points are now anti-aliased in the Advanced viewport and they also respect the viewport point size options for both foreground and background mesh layers.

Modo VR Component Selection and Editing

You can now select polygons, edges, and vertices in VR, and use a set of common modeling tools.

File I/O

Unreal Bridge

Improvements have been made to the Modo Bridge for the Unreal Engine. Transforms are taken care of automatically, lights and cameras are now supported, data transfer speed has been increased significantly.
MeshFusion

- **Hybrid Strip Topology** - Modo allows you to add skirt geometry to surface strips to allow greater control over topology around strip surfaces.
- **Fusion Instance Synchronization** - You can now control Fusion Item instances. All or selected instances can by updated, and the source can be updated from an instance.
- **New Corner Geometry** - The mesh algorithm has been improved so the topology generated at the corners of a Fusion Item is quad-based, resulting in a much smoother flow of polygons. This improves both positive and negative corners.
- **Surface Strip Command Tweaks** - You can now quickly swap fusion states. Hold the Alt key to swap between Surface Strips' boolean states.

Modeling and Asset Creation

**Coplanar Falloff**

The new Coplanar falloff type affects faces that are located on the same plane as the selection and uses the angle between normals.

**Depth Limitation Option for Snapping**

A new **Depth Limitation** option has been added to snapping. With this option you can limit the snapping range to a specified depth.

**Edges to Curves Improvements**

A new **Delete Geometry** option has been added to the **Edges to Curves** mesh operation, allowing you to delete all non-curve geometry from the mesh.

**Linear Align Tool Options**

New **Align to First Selected, Screen Axis**, and **Axis Vector X, Y, and Z** options have been added to the Linear Align direct modeling tool, allowing you to align selected vertices, edges, polygons, or UV positions along a line.

**Procedural Convert UV to Mesh**

A new **Convert UV to Mesh** operation has been added that allows you to convert a UV map to a mesh item procedurally.
Procedural Curve Convert Tool
A new procedural Curve Convert mesh operation has been added to convert selected curves to either a regular, Bezier, or B-Spline curve type.

Procedural Curve Offset by Mesh
The Curve Offset by Mesh operation has been added, allowing you to create parallel curves for a curve, offset by a separate mesh item. This mesh operation is also used for creating double stitching.

Procedural Hard Edges
New mesh operations have been added to work with hard edges procedurally. They are Hard Edge, Hard Edge Convert, and Select by Hard Edges.

Procedural Jitter Tool
A new procedural Jitter mesh operation has been added to reposition selected items or components based on a seed number and a range value for the X, Y, and Z axes. It applies a random offset to each vertex for a more random, organic appearance.

Procedural Merge Meshes Polygon Types
New polygon type properties have been added to the Merge Meshes tool to specify what type of polygons you wish to extract from a mesh.

Procedural Pack UVs Tool
A new procedural Pack UVs mesh operation has been added to automate the process of organizing UV island data to fit into the desired UV space.

Procedural Rectangle Tool
A new procedural Rectangle mesh operation has been added to straighten quadrangle selections of UVs into rectangular sections. This tool has options to automatically position and to regularize the spans into even grids.

Procedural Select Ring Tool
A new procedural Select Ring mesh operation has been added to select all the vertices or edges at the same selection direction around the globe of the geometry.
Procedural UV Fit Tool

A new procedural UV Fit mesh operation has been added to scale the currently-selected UV data to fill the normalized 0 to 1 UV space. This is a very useful tool for optimizing UVs.

Procedural UV Unwrap

A new UV Unwrap mesh operation has been added, allowing you to create UV maps for meshes procedurally.

Procedural Vertex Set Position

A new procedural Vertex Set Position mesh operation has been added, allowing you to reposition existing vertices to a specific position by specifying new coordinates.

Procedural Vertex Split

A new Vertex Split operation has been added, allowing you to split a vertex into multiple vertices procedurally.

Stitching Workflow

Modo now offers a quick and easy workflow to add and build stitches using the Stitch Mesh Setup command.

Performance Improvements

Vertex Normal Performance

Improvements have been made to the CPU performance when working with vertex normals. Vertex normals provide an efficient way to smooth shade a polygon mesh, giving it the appearance of a much higher poly mesh. In addition, the rendering process is approximately 50% faster.

UI

Bounding Box Threshold

A Bounding Box Threshold option has been added to the OpenGL Display Preferences. It allows you to draw items as bounding boxes above a specified GL polygon count, when the scene is rotated, panned, or zoomed in the viewport. This makes working with large scenes easier by eliminating delay in the viewport.
Clip Choice and Preset Browser Improvements

Improvements have been made to the Clip choice and the Preset Browser to make them faster, more visually consistent, and easier to navigate. Thumbnails are now saved as part of the Dir cache when using Clip Choice.

Form Workbenches

Workbenches are areas of the UI where tools, commands, scripts, presets, kits, channels, and macros can be grouped and organized. You can also make any form in Modo editable directly in the UI.

Item Notes

A Notes section has been added to the Item Properties. The description and comments added here are displayed as tooltips in both the Items list and the 3D viewport. The Items list can now be filtered based on the notes associated with items.

Modo Markup

Modo's text markup feature that allows you to add formatting to tooltips.

UVing

Transfer UV Positions

The Edit UVs Transfer UV positions option has been improved. In our prior versions, transferring UVs from one object to another identical object, you could only transfer one UV island at a time even if the object was continuous. Now the tool transfers all UVs of connecting polygons to the destination.

UV Box Transform Tool

New Gaps and Gaps By Pixel options have been added to the UV Box Transform direct modeling tool to allow you to add pixel border padding to your UV islands. You can manipulate the size of the gaps by using the box handles in the UV viewport.

Rendering

NVIDIA® OptiX™ Denoiser

You can now use NVIDIA’s OptiX Denoiser for denoising render outputs on supported systems (Windows and Linux systems running NVIDIA GPUs).
3D Viewport Improvements

Display Subdivision Weight

Modo now displays the weights of Subdivision weight maps the same way as regular weight maps when the Show Weightmap option is enabled in the 3D viewport settings.

Show Locked Mesh Items

You can now see locked mesh items easily in the 3D viewport. By default, the new preference Show Locked Mesh Items option is enabled. Selected vertices, edges, or polygons on a mesh item are displayed in a specified color. When loop selecting or using other selection methods, locked elements are not selected. Changing the color of the locked elements, is done in the Systems > Preferences > Display > Color > PSUB Mask settings.

Feature Enhancements

- **BUG ID 311221 - UV Connectivity** mode has been added to the UV Paste command.
- **BUG ID 341337 - Modeling:** A Deform Space option has been added to Selection Action Center and Action Axis Selection.
- **BUG ID 346181 - UV:** The Set Gaps by Pixel option has been added to have old gaps scope as an option. This fixes oddly positioned UVs.
- **BUG ID 355811 - Render:** Modo's performance during sampling of an image in ray evaluation has been improved. The limit on the number of UV render outputs has been increased, limit checking has been added, and the UV output index is now reset to zero.
- **BUG ID 366043 - UI:** The Animation Toolbar has been revised. The Spacing Chart and Inbetween buttons have been moved into the same row as the Dynamic Parenting and Motion Path buttons.

- File I/O: `-import`, a command line argument for adding session-only config paths has been implemented. It takes a path, dir or config file, which is added as a new session-only import path in the config system. The path is not written to the config on quit, and directories are not created if they don't exist yet. This is used like any other import path, in that configs are loaded from it and scripts can be launched from it.
- Preset Browser: ClipChoice has been converted to PBView and clips synthetic.
- Procedurals: The EdgeToCurve command now takes a poly type `arg`, or guesses based on the underlying geometry type.
- Scripting: The pure UI mode for user.value commands has been added, set through user.def uiMode, which supersedes the old asUI property, although that is still supported for backwards compatibility (uiMode takes precedence, if present). undoModel, undoUI and pureUI modes are supported.
• UI: \texttt{?min/?max} query operator support has been added to numeric edits via text hints and UI hints.
• UI: Access to viewport options from tabbed viewports with their tabs hidden has been made easier. The Viewport Properties menu in a tabbed viewport now shows the settings for the current tab instead of being disabled. The Viewport Properties have been mapped to the \texttt{O} keyboard shortcut globally. This triggers the Viewport Properties menu for any viewport under the cursor.
• UI: New Dynamics and Particles toolbars have been added to the Modo layout.
• UI: Icons and text labels on buttons have been shifted up one pixel (non-GL). This generally improves center of text and icons in faces.

Bug Fixes
• BUG ID 221462 - Viewports: Selecting Material selection mode in the Advanced viewport caused the mesh to become white.
• BUG ID 227428 - Shader Tree: Texture Replicators did not align to particles.
• BUG ID 242741 - Item List: Creating groups caused the folder to jump to a random position if the items were not selected in a top-down sequence.
• BUG ID 246494 - VR: Antialiasing/supersampling and drawing circular points did not work as expected.
• BUG ID 273105 - Rigging: Adding pre/post transform commands added a transform for the selected transform and then another for the selected root item.
• BUG ID 287965 - Presets: Using Preview in Sphere Preset mode only rendered using the selected material rather than the one at the top of the Shader Tree.
• BUG ID 289613 - UI: Duplicating a form containing a reference didn't work correctly.
• BUG ID 290832 File I/O: The Save Incremental action sometimes didn't use the correct file name.
• BUG ID 293954 - Modeling: Adding another Falloff on top of a Soft Selection falloff in Topology mode caused the Move tool to become unresponsive.
• BUG ID 294389 - Particles: The Density Gradient property in the Surface Particle Generator did not have any effect on the particle distribution.
• BUG ID 295747 - Viewports: The Clearcoat Bump setting was ignored in the Advanced viewport.
• BUG ID 304359 - File I/O: Certain irregular meshes caused Modo to crash upon loading.
• BUG ID 304634 - Modeling: Applying Edge Bevel over boundary edges didn't work as expected.
• BUG ID 310920 - Deformers: Using deformed instances produced visual 3D viewport glitches in certain camera perspectives.
• BUG ID 313352 - UV: Locked polygons were ignored by the Pack UVs tool.
• BUG ID 313910 - Procedurals: The Merge Meshes operation only partially imported UVs not at the top of the Mesh Operation list.
• BUG ID 320292 - Procedurals: Connecting a Surface Particle Generator as a Clone Source caused Modo to crash.
• BUG ID 330815 - Baking: Selecting a Texture Output in a Bake Item using RayGL Bake caused Modo to crash.
• BUG ID 334413 - Presets: Dragging material masks into the Preset Browser didn't save the correct thumbnail for the preset.
• BUG ID 335229 - Procedurals: The Detriangulate mesh operation didn't work with selected triangles.
• BUG ID 341386 - Procedurals: The **Curve Rebuild** operation’s **Exact Distance** option was not exact.
• BUG ID 343437 - Procedurals: The **Merge Meshes** operation didn’t connect to the Surface Particle Generator inputs.
• BUG ID 344024 - Modeling: Using the **Bevel** tool along with the **Thicken** polygon option created unexpected polygons.
• BUG ID 344583 - Viewports: The **3D Viewport Properties** didn’t display correctly when the **Preview** viewport was already open on start-up.
• BUG ID 345000 - Modeling: Undoing an Axis Drill (stencil) failed to completely undo.
• BUG ID 345025 - UV: The **Backdrop Image’s Transparency** option in the **UV Viewport Properties** didn’t work correctly.
• BUG ID 345080 - Modeling: Using Boolean operations on background geometry with overlapping polygons caused Modo to become unresponsive and consumed a large amount of RAM.
• BUG ID 345337 - Procedurals: Non-active deformers left selected elements behind.
• BUG ID 348211 - UI: Switching to the **Polygon** tab after selecting edges disabled several commands incorrectly.
• BUG ID 349259 - Procedurals: Using the **Select by Previous Operation** with the **Edge Bevel** mesh operation didn’t always return all the edges.
• BUG ID 349260 - Modeling: **Transfer Normals** didn’t work correctly for mesh items that didn’t have matching transforms.
• BUG ID 349467 - Preview Render: Enabling the Preview renderer in the **Render** layout with the **RayGL Options** window open caused Modo to crash.
• BUG ID 349987 - File I/O: Importing an Alembic file (point cloud) set as a **Point Source** for a Replicator item caused Modo to crash.
• BUG ID 350303 - Viewports: Editing the **Film Roll** option while viewing a camera in the **Advanced** viewport caused wireframes to explode.
• BUG ID 350304 - Modeling: The Edge Extend tool was very slow compared to the Move tool.
• BUG ID 350305 - File I/O: Loading backdrop images caused Modo to crash.
• BUG ID 350352 - Viewports: Vertices appeared when the **3D Viewport Properties > Active Meshes > Display > Show Vertices** option was set to **Never**.
• BUG ID 350370 - Modeling: Using Transfer Vertex Color map (RGBA) caused Modo to crash.
• BUG ID 349671 - Navigation: Pressing the **G** key to center the view on the cursor’s position did not work properly with a custom **Work Plane**.
• BUG ID 350691 - Modeling: Vertex Snapping didn’t highlight vertices in some cases.
• BUG ID 350834 - Animation: Undoing a Box Tool edit in the Graph Editor caused the box to jump back to its previous position on the next action.
• BUG ID 350933 - Particles: The **LookAt** Particle Modifier compressed particle transforms.
• BUG ID 351622 - Animation: Mini Gradient popovers entered incorrect values for time.
• BUG ID 351710 - Viewports: Red materials appeared in the **Advanced** viewport if a scene contained many meshes.
• BUG ID 351829 - Shader Tree: Editing a constant layer in a group with **Apply to SubGroup** enabled caused Modo to crash.
• BUG ID 351841 - Procedurals: Selecting a mesh that was part of a mesh operation for another mesh changed its GL display.
• BUG ID 351866 - Modeling: Enabling and disabling the **Toggle Grid Workplane** option hid the widget for some deformers.
• BUG ID 351884 - Modeling: Mirror tool: Merge vertices didn't work correctly.
• BUG ID 352132 - File I/O: Reverting a scene with the Mesh Paint tool active caused Modo to crash.
• BUG ID 352326 - UI: **Undo To Here** in **Command History** didn't work.
• BUG ID 352353 - Modeling: The **Polygon Inset** distance was not a consistent width. There is now a new **Offset Even** option.
• BUG ID 352377 - Viewports: Dragging Shader Tree layers between different groups in the **Advanced** viewport didn't work as expected. Layer masks either didn't appear when moved into a group and/or the layer mask leaked out, affecting the next parent group layer.
• BUG ID 352377 - Viewports: Layer masks nested within a group mask sometimes didn't display in the **Advanced** viewport.
• BUG ID 352438 - UV: Opening the UV list in UV view after editing the Transform UV Map operation's **Tile U/V** values caused Modo to crash.
• BUG ID 352496 - Procedurals: Deleting an edge with procedural modeling broke the UV map.
• BUG ID 352685 - Viewports: Disabling **Use Normal Maps** in the **Advanced** viewport affected the lighting.
• BUG ID 352909 - Viewports: Moving directional lights was slower than expected.
• BUG ID 352963 - Procedurals: The Procedural Axis Slice tool and the direct modeling Axis Slice tool produced different results.
• BUG ID 353035 - UV: Switching to a layout with material overrides on while the UV Box Transform tool was active caused Modo to crash.
• BUG ID 353068 - Particles: There were precision issues with Curve Particle Generator’s spacing distance.
• BUG ID 353250 - Modeling: The Polygon Bevel tool’s **Square Corner** option didn’t always work.
• BUG ID 353278 - Baking: Using Bake Preview with a Render Output Bake item that had its output assigned to a folder caused Modo to crash.
• BUG ID 353589 - Viewports: Rotating environment images was very slow.
• BUG ID 354063 - Procedurals: UV creation in Procedural mode displayed an invalid progress bar.
• BUG ID 354323 - Viewports: The **Advanced** viewport did not show displacement.
• BUG ID 354360 - File I/O: Loading Alembic files with transforms of unknown types caused Modo to crash.
• BUG ID 354384 - VR: Connecting the monitor display and HMD display to separate GPUs caused Modo to crash.
• BUG ID 354588 - Modeling: Hard Edge Smoothing incorrectly hardened all edges on vertices.
• BUG ID 354600 - Procedurals: Polygon Bevel incorrectly set minimum value of segment to 1.
• BUG ID 354680 - Particles: Particle Rotation gradients were only rotating 1 degree per 100%.
• BUG ID 354891 - UI: The Modo interface sometimes did not load when it couldn't display a layout. Now Modo displays an empty but usable layout in such cases and allows you to restore another layout or build a new one.
• BUG ID 355035 - Modeling: Paint selection in **Items** mode randomly caused Modo to crash.
• BUG ID 355062 - Modeling: Getting the bounding box for a face randomly caused Modo to crash.
• BUG ID 355166 - Painting/Sculpting randomly caused Modo to crash.
• BUG ID 355225 - Procedurals: Undoing a mesh operation freeze caused Modo to crash.
• BUG ID 355357 - Preview Render randomly caused Modo to crash.
• BUG ID 355406 - Volumes: Opening scene with a VDB voxel item selected caused Modo to crash.
• BUG ID 355568 - Viewports: Environment images sometimes caused Modo to crash.
• BUG ID 355577 - Viewports: Viewport drawing sometimes caused Modo to crash.
• BUG ID 355579 - Procedurals: Using the Polygon Merge mesh operation sometimes resulted in corrupted vertex normals.
• BUG ID 355580 - Input Devices: Space Navigators with a tool active sometimes caused Modo to crash.
• BUG ID 355664 - UV: Random crashes related to UV coverage.
• BUG ID 355787 - Item List: Selecting an item with no linked transforms sometimes caused Modo to crash.
• BUG ID 355920 - Procedurals: Implicit selection did not work for SelOp aliases.
• BUG ID 356029 - UV: The UV Rectangle's Gaps option was incorrectly available when Pack was disabled.
• BUG ID 356117 - MeshFusion: The Absolute strip quad length feature introduced in 12.1 created quads twice as long as the length specified by the user in millimeters.
• BUG ID 356132 - Procedurals: Using the Transfer Vertex Map operation with Select by Previous and Boolean mesh ops caused Modo to crash.
• BUG ID 356235 - Replicators: Replicators with their Point Source set to a Particle Snap Modifier sometimes collapsed to a single edge.
• BUG ID 356402 - UV: Slow performance using UV coverage.
• BUG ID 356419 - Procedurals: Procedural Edge Slide provided different results if a selection was made, then the layout was swapped.
• BUG ID 356669 - Viewports: Large scene performance on Quadro Cards has been improved. This change reverts the workaround introduced in Modo 12.1, because the custom NVIDIA driver profile has been removed in Modo 12.2 as NVIDIA has fixed this for a future driver release.
• BUG ID 357026 - UI: The Form Editor changed message table entries not on the form.
• BUG ID 357224 - Item List: Switching from a CAD-converted scene to another scene caused Modo to crash.
• BUG ID 357278 - Viewports: Input lag when using certain view styles with an environment image enabled.
• BUG ID 357316 - Painting: Using Projection Ink sometimes caused Modo to crash.
• BUG ID 357322 - Modeling: The Soft Selection falloff was drawing on locked and hidden geometry.
• BUG ID 357383 - Procedurals: Beveling irregular edges sometimes caused Modo to crash.
• BUG ID 357386 - Modeling: The Component AutoSelect button didn’t highlight consistently when activated by its keyboard shortcut.
• BUG ID 357606 - Procedurals: Adding a mesh operation after activating the Sketch tool sometimes caused Modo to crash.
• BUG ID 357992 - File I/O: macOS - Using Export Selected and saving to the same directory more than once resulted in an error message.
• BUG ID 358466 - Schematic: Selecting a link and pressing Delete displayed an error.
• BUG ID 358487 - Licensing: License libraries bug involving a number of MacOS issues related to sign-in licensing problems with changing MAC IDs and other issues.
• BUG ID 358572 - Modeling: The Linear Align tool’s Screen Axis mode was not available in all selection modes.
• BUG ID 359403 - UI: Pressing Tab after typing a value in the Horizontal Wrap field didn’t work as expected.
• BUG ID 359627 - UV: Potential crash in mesh meta computation with 1 or 2 points polygons.
• BUG ID 359784 - Modeling: Using the Action Axis tool sometimes caused Modo to randomly crash.
• BUG ID 359790 - Modeling: Using Element Falloff in Edge mode sometimes caused Modo to randomly crash.
• BUG ID 359795 - Modeling: Enabling tools sometimes caused Modo to randomly crash.
• BUG ID 360051 - Procedurals: The Slice mesh operation left behind vertices resulting in open geometry.
• BUG ID 360061 - VR: ModoVR did not show the HMD view in the viewport on AMD+Oculus.
• BUG ID 360066 - Viewports: Updating bump or displacement sometimes caused Modo to crash.
• BUG ID 360306 - Procedurals: Using the Select by Previous selection type with an Axis Drill mesh operation sometimes caused Modo to crash.
• BUG ID 360595 Modeling: Smoothing angle was not correctly applied to polygons that shared a vertex and had different material groups and smoothing angles.
• BUG ID 360598 - Viewports: The Unreal Shader did not use Clearcoat normals for clearcoat effect in the Advanced viewport.
• BUG ID 360642 - Procedurals: When creating a new mesh operation, or selecting a mesh operation in the Mesh Operations list, the properties were not displayed correctly.
• BUG ID 360784 - Procedurals: Trying to select a component on the mesh sometimes caused Modo to crash.
• BUG ID 360857 - UI: Deleting an image in the Modo layout caused Modo to crash.
• BUG ID 360934 - Procedurals: Group polygon bevel didn't use the same random value per group.
• BUG ID 360990 - Procedurals: Merge Meshes didn't handle negative scale correctly.
• BUG ID 361020 - Viewports: Switching layouts caused Viewport Overrides to create undos without an undo context.
• BUG ID 361022 - Item List: Removing a package from an item incorrectly deselected the item.
• BUG ID 361050 - Animation: Animation playback sometimes consumed a large amount of RAM.
• BUG ID 361304 - Shader Tree: Deleting an image from the Clips list caused Modo to crash.
• BUG ID 361313 - Modeling: Edge loop selection did not work as expected when boundary edges were involved.
• BUG ID 361409 - UV: Texture Name channel of UV Pack and UV Unwrap was a text field instead of a popup.
• BUG ID 361557 - Shader Tree: In certain scenes, normals were affected by incorrect material masks.
• BUG ID 361562 - Procedurals: The Scatter Clone mesh operation incorrectly flipped geometry.
• BUG ID 361564 - Procedurals: When making a slice on a polygon, the created edge was detached from the geometry.
• BUG ID 361604 - Preset Browser: Files with too many numbers in the file name did not appear in the Preset Browser.
• BUG ID 361742 - File I/O: macOS - Selecting the same directory more than once for the UDIM Wizard displayed an error message.
• BUG ID 361884 - Navigation: Move/Orbit from a PRS-Channel-Locked Camera displayed several warnings.
• BUG ID 361908 - Modeling: Auto Action Center used Deformed Axis and Center even if Enable Deformers was disabled.
• BUG ID 362180 - UI: Windows - Japanese locale - Rebuilding the Item List while the scene cinema was in flux caused Modo to crash.
• BUG ID 362284 - Viewports: Random crash involving tools.
• BUG ID 362379 - Customization: Adding a command from custom config to a form caused Modo to crash.
• BUG ID 362621 - Painting: Activating the Stamp brush caused Modo to crash.
• BUG ID 362940 - Preset Browser: When a file was dropped from the file system into a Preset Browser and its original location was not already present in the Preset Browser's directory cache, the file was copied rather than moved.

• BUG ID 362954 - Modeling: Instancing or duplicating a corrupt mesh caused Modo to crash.

• BUG ID 362972 - Python API: When Modo was looking up the argument type from the Python command, the default implementation gave a 'Not Implemented' exception rather than returning None/NULL. This caused the text hints to fail for Python commands.

• BUG ID 363063 - Viewports: Using the Matcaps shader in the Tool viewport sometimes caused Modo to crash.

• BUG ID 363933 - MeshFusion: Increasing strip width resulted in geometry disappearing.

• BUG ID 363947 - Presets: Saving an Environment preset had the preset sphere in the thumbnail.

• BUG ID 363948 - Presets: Saving a Shader or Render Output preset rendered the default material as thumbnail.

• BUG ID 363950 - Presets: Environment preset thumbnails were not color corrected.

• BUG ID 363981 - Item List: Random crash related to the Item List.

• BUG ID 363993 - Shader Tree: Random crash in texture evaluation, including reports of crashes when exporting to .fbx.

• BUG ID 364011 - Volumes: Rendering scenes with VDB Voxels sometimes caused Modo to crash.

• BUG ID 364098 - Preview: Using any Preset shape as geometry material preview, and selecting a Render Output while Preview was running caused Modo to crash.

• BUG ID 364177 - Modeling: The Thicken tool produced different results in Modo 12.1.

• BUG ID 364941 - Preview Render: Enabling a Viewport override preset with Preview rendering caused Modo to crash.

• BUG ID 365470 - Modeling: The Smooth Shift Sharpen option created asymmetrical results.

• BUG ID 365654 - Modeling: The Push and Jitter tools were reset with every click.

• BUG ID 366009 - UV: The Pack UV tool's Pack Region options kept resetting to default.

• BUG ID 366134 - Modeling: Converting Edge selection to Polygon selection didn't always work as expected.

• BUG ID 366297 - UV: Texel density kit incorrectly accounted for 3D size when sampling.

• BUG ID 366385 - UV: Looping select UV Seam that bordered a split edge caused Modo to crash.

• BUG ID 366476 - UV: The UV Box Transform tool's Snap Distance option ignored the zoom level.

• BUG ID 367026 - Modeling: Random crash related to edge tracking.

• BUG ID 368667 - Procedurals: The Clone Effector handled vertex selection incorrectly.

• BUG ID 369125 - Modeling: The handles of Bezier curves imported from Illustrator could not be edited correctly.

• BUG ID 369171 - UV: Zooming in and out with the scroll wheel in the UV viewport caused Modo to crash.

• BUG ID 369447 - UV: The UV Box Transform snapping overrides constrained proportions.

• BUG ID 369788 - Procedurals: Slice sometimes left a vertex floating in space when cutting a curve into two parts.

• BUG ID 370148 - UI: Dragging the Render Camera label from the Render Item form caused Modo to crash.

• BUG ID 370375 - UV: Copying and pasting an edge selection with UV connectivity caused Modo to crash.

• BUG ID 370380 - Modeling: Removing an item while Geometry Snapping was enabled in the Toolpipe caused Modo to crash.
• BUG ID 370597 - Modeling: A specific n-gon Bevel left one vertex behind.
• MeshFusion: Command Help for user values driving various popup menus were missing. A minor config issue was preventing some icons from displaying in the Fusion Item’s Properties.
• Particles: Exotype for Texture Particle size was a float instead of a distance.
• Preset Browser: Saving some presets didn’t create a new directory (important for user paths from the Preset Browser).
• Preset Browser: The Preset Browser sometimes didn’t update when changing to a different directory.
• Procedurals: The Material mesh operation was much slower than the Assign Selection Set mesh operation.
• Scripting: The wrong notification flag was sent for the command enable set on a user value. `invert enable command test` has been added for user.def, which inverts the results of the test for the enable command. This allows the user value to be enabled when the enable command is disabled and visa versa.
• Shader Tree: Changing material surface normal properties affected the wrong item in a specific scene.
• UI: Usernames on some data list layouts were incorrect in the Data Lists switcher bar.
• UI: Tool Properties: The Snapping button so it remained in the Properties after the tools were dropped.
• UV: Random crash related to UV Coverage drawing.

**Known Issues and Workarounds Specific to this Release**

This section covers known issues and gives workarounds for them, where appropriate.

NOTE: Due to internal bug-logging and tracking process improvements, new bug identification numbers are used, with the legacy IDs provided in parentheses, where appropriate.

**Animation**

• BUG ID 240321 (53661) - Selecting actions does not always select the correct one. This is caused by copying actions.

As a workaround, manually edit the tags on the broken actions by selecting them in the Groups tab, then save and reload the scene.

**Assemblies**

• BUG ID 288164 (36452) - Assemblies exported from the Item List context menu result in poor visual layout of nodes on import.

As a workaround, you can save assemblies from the Schematic viewport.

**Baking**

• BUG ID 355201 - Baking SurfaceID is giving different outputs. A bug has been fixed where deleting or disabling visibility of a mesh would change the SurfaceID colors of other meshes. The process is now deterministic, but the SurfaceID colors differ from previous versions.
• BUG ID 293020 (50671) - Baking displacement maps can cause UV seams to be visible, and the baked displacement map to show quilting effects and other render artifacts.
• BUG ID 221481 (49437) - The Bake Channel Swizzling option can’t bake to texture alpha.

Color Management
• BUG ID 221439 (49244) - (Windows only): With Perform Color Correction on, setting a default scene to a scene with a mesh that has a position channel crashes Modo at launch.

As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default scene.

Command Line
• BUG ID 289290 (49514) - macOS X only: Running modo_cl before running the UI Modo application breaks code signing.

As a workaround, start the UI version of Modo once, before running modo_cl on any system where you later intend to use the UI version.

File and Image I/O
• BUG ID 337523 (56862) - Modo for SolidWorks Kit: Modo crashes when importing the same SolidWorks file twice in one Modo session. This bug only affects import using the kit, not direct imports (File > Import).

As a workaround: Before importing a SolidWorks file for the second time, exit and restart Modo.
• BUG ID 221508 (50198) - Alembic scenes don’t export some surface items, including static meshes and procedural shatter items.
• BUG ID 226589 (49728) - Exporting selected layers (from the Item List context menu) to .fbx doesn’t export instances, unless the original mesh is also exported.

To resolve this, set the .fbx preference to Export Selection and use Export As....
• BUG ID 220991 (47036) - Color management in .svg images is not currently supported. This is a side-effect of a bug fix where the largest allowable image size (64k x 64k) was always used when color correction was enabled.
• BUG ID 220975 (46962) - Rendering .svg images used as stencil maps for displacement or for layer masking can be very slow.

Fur
• BUG ID 288248 (35731) - Fur length textures can’t be edited with the Stretch tool.

As a workaround, use different fur length drivers, such as hair guides or vector vertex maps.
Input Devices

- **BUG ID 303287 (35856)** - Linux only: Plugging in a Wacom tablet while `[[[Undefined variable Modo/] Variables.Product]]` is running can cause undesired movement. This cannot be fixed, due to a limitation of the hardware driver.

To avoid this, plug in the tablet before application start-up or restart.

- **BUG ID 226536 (51741)** - Mac OS X only: Modo sometimes becomes unresponsive when using the combination of a click-drag in a tree view (for example, when toggling the visibility of two successive items in the Shader Tree), followed immediately by a two-finger scroll gesture on some devices, including laptop trackpads and the Magic Mouse.

As a workaround, change to a 3-button mouse (recommended to fully access all of Modo's features).

MeshFusion

- **BUG ID 364399** - Outputting an Airtight Final mesh may flip some polygons.

As a workaround, select the polygon in Polygon mode and press the F key or convert the mesh to SubDs or PSubs (Tab or Shift+Tab).

- **BUG ID 316276 (56973)** - If a Trim Fusion role is assigned to an object and then it is dragged and dropped onto a Primary, the drop menu does not contain the Trim boolean options.

As a workaround, use either the Fusion buttons (Tool palette - Set Mesh Role & Apply section) or Pie Menu (Apply Subtraction or Apply Intersection) when initially adding Trims to each Fusion Item (Trims can contribute to multiple Fusion Items). If initially applied with either of those methods, all subsequent Drag & Drop options will be supported.

Modeling

- **BUG ID 226970 (32728)** - Zooming out with a Space Navigator alters the Work Plane position.

Network Rendering

- **BUG ID 226363 (48325)** - Scenes with image sequences rendered with Full Frames use the wrong image sequence number on slave machines.

As a workaround, use File > Consolidate Scene, then render the scene using a shared network folder (Preferences option under Rendering > Network Rendering).

- **BUG ID 226337 (36986)** - Slaves render hidden meshes. Since mesh hide state is not stored in the scene, when that scene is transferred to the slaves, the state is lost. The master respects the hidden state, however.

As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or open System > Preferences > Rendering and disable Use Network Render Nodes.

- **BUG ID 226336 (25636)** - Frame passes are not supported.
• BUG ID 220955 (30318) - Network Rendering doesn’t support Realflow particles.
• Several Bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not implemented to support baking. Changes to Modo in the 10-series apparently broke what was working for some artists, so the functionality has been disabled.

As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an external render controller. For more information, please see the SDK Wiki.

Nodal Shading
• BUG ID 221393 (50642) - Nodal shading does not support UDIMs.

Painting/Sculpting
• BUG ID 288461 (41682) - Textures are not always updating in Preview/Render when painting on an image map.

You can save and reload the image to force the update.

Particles
• BUG ID 303192 (34925) - Re-opening scenes saved with large particle caches can cause problems.

To avoid such issues, delete the cache before closing Modo, or export the particles to .csv cache files or Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation item in the Schematic viewport, and clicking Cache Simulation.

Preview
• If a high poly mesh is not visible, the Preview baking output will be incorrect.

As a workaround, reset Preview to fix the baking.

Procedurals
• BUG ID 305303 (56318) - Procedural duplication of Mesh Ops in a Deform folder creates errant Mesh Ops list.
• BUG ID 305302 (56317) - Duplication of Procedurals does not work with the Select By Previous Operation tool.

As a workaround, manually edit the duplicate’s Select By Previous Operation Mesh Ops.
• BUG ID 266469 (54738) - A duplication of any item that is a Merge Meshes Source (For example, a Mesh Item, Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to the Merge Meshes Ops List as a source.
As a workaround, remove the unwanted additional Merge Mesh Sources (regardless of the type of source) in the Mesh Ops List using the X icon in that list next to each Merge Meshes source.

- **BUG ID 221355 (52149)** - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal option doesn't work when using a Bezier with zero-length tangents.

As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there are no zero-length tangents.

- **BUG ID 289810 (46512)** - When rigged, Rock items and other procedurals do not display correctly in GL. This is a limitation of the feature and will not be fixed.

You can use Preview or RayGL to visualize the variations from rigging.

**References**

- **BUG ID 294394 (44492)** - If a scene that already contains references is referenced, the shading of the original references may not persist.

As a workaround, limit scenes with shading to one level of reference.

- **BUG ID 220957 (41119)** - Reloading a reference after replacing it with the same file can cause Modo to crash.
- **BUG ID 309252 (56620)** - Modo crashes when closing a scene containing a referenced scene after attempting to revert a reference override.

As a workaround, first close and reopen the scene before attempting to revert the reference.

**Rendering**

- **BUG ID 297021 (52730)** - The Vertex Illumination Bake command doesn't work as expected, when the mesh has transform channels.

As a workaround, freeze the transforms in the mesh properties.

- **BUG ID 292947 (53184)** - Value presets created for material Subsurface Scattering samples in Modo 10.1 or earlier now show on the render item instead.
- **BUG ID 279848 (55663)** - Motion Blur applied on a curve in a mesh operation no longer works.
- **BUG ID 243070 (53793)** - Rendering using a Dual CPU with 72 threads was significantly slower than expected.

As a workaround, any machine that has more than 32 cores, performance will be better if you limit rendering to half the number of cores you have.

- **BUG ID 235368 (53411)** - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels) in some cases.

As a workaround, use a Maximum Radiance higher than 1 W/srm² to reduce the bias.

**Rigging**

- **BUG ID 287584 (27244)** - Duplicating joints in a bound mesh retains influences from the original joint chain.
Scripting

• BUG ID 242545 (53458) - Right-clicking or running a script in the Script Editor can lock up input to Modo.
  
  As a workaround, click in the top window of the Script Editor, use the main menus, or change to another application, then switch back to Modo.

Shader Tree

• BUG ID 336112 (57874) - Custom Materials that define their own smoothing properties (such as the Skin material), no longer smooth the mesh correctly.

• BUG ID 299187 (37858) - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip browser) fails.
  
  To work around this issue, in the Clip Browser, choose a single image instead of the group, and then change to the image group using the Texture Layer's Properties tab.

• BUG ID 288141 (30947) - Layer masking displacement does not work unless you drag and drop the masking layer onto the displacement layer.

Unreal and Unity Materials

• BUG ID 295862 (50700) - There is no way to visualize the Unreal SubSurface Color effect in Modo.

• BUG ID 294747 (50701) - Unreal material Ambient Occlusion does not bake correctly in Modo.

• BUG ID 221477 (50451) - On some graphics cards, Unity material may cause flickering in the Advanced viewport when used with bump maps and shadows.

UI

• BUG ID 333249 (57715) - Selecting items in the viewport does not always update the Properties form.
  
  As a workaround, press the Alt key.

• BUG ID 288714 (43162) - Windows only: Setting a custom text size affects Modo’s text drawing.

  As a workaround, go to the compatibility settings by right-clicking the Modo shortcut or executable, and turn off font-scaling for the application.

• BUG ID 281374 (55759) - Transforming objects can cause the Items Properties panel to flicker.

• BUG ID 277244 (55571) - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.

• BUG ID 273139 (55185) - Text in the viewport icon buttons is not visible in the Advanced viewport on some macOS/AMD configurations.

  As a workaround: Upgrade macOS to 10.12 or 10.13.

• BUG ID 226492 (44496) - macOS X only: Disabling Affect System Color Dialog in Preferences > Rendering > Color Management, and using the system color picker caused colors to darken with each use of the color picker.
This is due to an OS X issue, which requires the color profile in both the monitor settings and color picker to be set to sRGB IEC61966-2.1.

- **BUG ID 224169 (44896)** - Dragging and dropping an image from disk into the **Clips** list doesn’t work.

  If the **Clips** list is empty, drop the image onto the bar at the top, otherwise drop it above or below other images in the list.

### Viewports

- **Windows only:** Using Raptr can cause GL driver crashes in Modo.
- RGBA textures only draw correctly in the **Advanced** viewport. In the **Default** viewport, any unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in the Shader Tree.
- **BUG ID 338599 (57955)** - Clicking on the VR layout tab may crash when using a system with a Radeon WX-series graphics card. This is due to a driver bug and should be fixed by an AMD in a future driver release.
- **BUG ID 338374 (58003)** - Game Navigation mode (camera rotation) does not work in a floating 3D view (palette or separate window).

  As a workaround, use Game Navigation mode only in docked 3D views (views that are part of a Layout).
- **BUG ID 310930 (56706)** - Unity and Unreal materials are not displayed correctly when first loaded into the **Advanced** viewport.

  As a workaround, enable and then disable the visibility of the Shader Tree textures.
- **BUG ID 296123 (46995)** - Ambient Occlusion display in the Advanced viewport is affected by selected item wireframes.

  You can disable **Show Selection** in the **Visibility** options or disable wireframe drawing on the active mesh layers.
- **BUG ID 289738 (49473)** - Projections are incorrect if the projecting camera is set to Vertical film fit mode and the width is less than the height.
- **BUG ID 289020 (43771)** - Camera projections from non-render cameras show distortion in GL and baking.

  To avoid this, make sure that the projection camera has a film width-to-height ratio that matches the main render camera.
- **BUG ID 281365 (55816)** - Wireframes are washed out on transparent surfaces in the **Advanced** viewport.

  As a workaround, avoid transparency when modeling or doing work where wireframes are needed. Alternatively, use the Default viewport.

### Developer Notes

- **BUG ID 356825** - SDK: TDSDK Vertex and Edge classes didn’t use the correct IDs for equality comparisons.
- **BUG ID 363748** - SDK: In some situations, the per_item callback was not called. (See this discussion: http://modo.beta.thefoundry.co.uk/forum/topic.aspx?f=11&t=25223)
- **BUG ID 364335** - TD SDK: The same vertex ID was being used repeatedly when trying to set disco UVs.
- **SDK:** SDK methods **StripRichText()**, to remove rich text in a string, and **StringLookup()**, to get a string from a string table have been added.